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Introduction
You have just purchased one of the most advanced lottery programs available.    Windows 
Lotto provides several analysis tools for Handicapping lottery numbers.    A Quick Pick 
function is included that automatically picks the best numbers to play, based on an analysis 
of previously drawn numbers.
The program also includes Number Systems (Wheels) for playing your lottery numbers.    
Windows Lotto checks the numbers you play each week against the numbers drawn and 
gives you a summary of winning tickets.    A search option is also provided that allows you to 
search the drawing database for winning combinations of numbers.
Related Topics:

Analysis Tools
Quick Pick
Wheeling Systems
Basic Operation
Hardware and Software Requirements



Analysis Tools
Windows Lotto provides the following analysis tools for handicapping lottery numbers:

* Number Statistics Chart
* Trend Chart
* Skip and Hit Chart
* Sequence Chart
* Repeating Pairs Chart
* Repeating Triples Chart
* Drawing Summary



Quick Pick
Window Lotto performs a statistical analysis of the numbers drawn in previous games.    
Numbers are grouped into several categories.    These categories include Hot Numbers, Cold 
Numbers, Due Numbers, Last Draw Numbers, Odd Numbers, Even Numbers, Sum of 
Numbers, 1 to 12 Numbers, 13 to 31 Numbers, and 32 and Up Numbers.    Averages and 
percentages are determined for each of the categories.
The Quick Pick option automatically picks your numbers based on the data collected for the 
above categories.    The numbers you play are then consistent with the statistics for previous
drawings.    If 50% of the numbers that are picked each week are Hot numbers, it is to your 
advantage if 50% of the numbers you wheel are Hot numbers.
In Quick Pick, if you wheel 10 numbers, the program automatically determines how many of 
those 10 numbers should be in the 1 to 12 range, 13 to 31 range, and 32 and up range.    
The number of numbers picked from the Hot, Cold, Due and Last Draw categories is based 
on previous drawing statistics.    
The numbers picked are saved to a Quick Pick file and used in one or more of the 24 
wheeling systems included with the program.



Wheeling Systems
Why use wheeling systems?    It can honestly be said that "Wheeling" reduces the odds 
against you!    
First, simply by playing more numbers (more than the standard six), in a group, you have a 
better chance of having the officially drawn numbers match your wheeled numbers.    
Second, by playing more tickets, you increase the odds mathematically of holding a cash 
paying ticket(s).    
Probably the greatest single benefit of "Wheeling" is the payoff maximization that is inherent
in a wheeling system.    Because you are playing several combinations of the same numbers,
when a few of these numbers are selected, they appear on your tickets in a "shotgun" 
fashion throughout the tickets you play.    
In many systems, if only four numbers appear in the larger group of numbers you wheel, 
multiple prizes will appear throughout your tickets.
All successful professional gamblers use wheeling systems.    The wheeling system concept 
provides a methodology for playing numbers and provides payoff maximization through 
multiple ticket wins.    It is a matter of personal choice as to whether or not you want to play 
the lottery.    However, if you do play the lottery, wheeling systems represent the most 
intelligent way to play and win!
Windows Lotto has 24 wheeling systems for Pick-5 and Pick-6 lotto games, and 20 wheeling 
systems for Pick-7 games.    These systems can be edited or replaced with other systems.



Basic Operation
Each week you will use Windows Lotto to update your data base file, check your tickets for 
winning games, pick the best numbers to play, and finally to wheel your numbers. 
The following topics give you general instructions on how to perform the above tasks in 
Windows Lotto.    Please refer to the Reference section for more detailed instructions.
Related Topics:

Updating Your Data Base File
Checking Your Tickets For Winning Games
Picking The Best Numbers To Play
Wheeling Your Numbers



Updating Your Data Base File
To effectively use Windows Lotto, you must have a data base file with a minimum of 21 
previous draws.    To create your own data base file, contact your lottery commission and ask
them to send you a list of the previous draws.
Once you have your list, choose the Create New Drawing File command from the Files 
menu to create your drawing file.    Once the file has been created, use the Open Drawing 
File command in the Files menu to open the file.    Finally, use the Edit command in the 
Drawings menu to add the previous draws from the list.
Since adding several hundred draws can be a tedious task, you may want to order your data 
base file(s) from Data Solutions.    Files are available for all US. lottery games, as well as 
several international games.
Once you have the previous draws entered in the file, keeping the data base up to date is 
easy.    Each time there is a new draw, use the Edit command in the Drawings menu to add 
the numbers that were drawn.



Checking Your Tickets For Winning Games
Every time you update your data base file with the official numbers from the last draw, you 
should use the Check For Winning Games command in the Drawings menu.    
This option shows you how many of your tickets had 3 or more matching numbers in the last
draw.    The option uses Game files that are saved when you Play one of the wheeling 
systems in the Wheels menu.
If you want to search several previous draws for winning combinations of from 3 to 18 
numbers, use the Search Drawings command in the Drawings menu.



Picking The Best Numbers To Play
Use the Quick Pick option from the Drawing Summary command in the Statistics menu 
to pick the best numbers to play, based on previous draw statistics from the Drawing 
Summary.
Prior to using the Drawing Summary/Quick Pick command, you may want to use some of 
the other analysis tools in the Statistics menu such as the Trend Chart, Skip and Hit 
Chart, Sequence Chart, Repeating Pairs Chart and Repeating Triples Chart.
For example, after looking at the Skip and Hit Chart and the Sequence Chart, you may 
determine that one or more numbers has a very high probability of hitting next.    In that 
case you may want to specify those numbers as Favorite numbers when you use Quick 
Pick.
The numbers picked in the Quick Pick option should be saved to a Quick Pick file.    The file 
will be loaded into the wheeling system(s) that you select.



Wheeling Your Numbers
Choose the Wheels menu command to Play one or more Wheeling systems.    After you 
have selected either a Full or Abbreviated wheeling system, you must select the name of 
the Quick Pick file that you saved earlier.    The numbers in the Quick Pick file are substituted 
into the system, and the resulting game tickets are displayed on the screen.
You should save the results to a Game file, so that you can later check for winning games 
using the Check For Winning Games command in the Drawings menu.    You should also 
print your game tickets so you can fill out your bet slips.



Hardware and Software Requirements
Hardware
Software



Hardware
To operate Windows Lotto, you should have the following:

* A computer with a minimum of 1 MB of RAM, although 2 MB is recommended for 
more efficient operation.

* VGA monitor
* Hard disk drive
* Printer



Software
Windows Lotto requires Microsoft Windows 3.0 or above to operate successfully.
 



File Menu
Open Drawing File
Create New Drawing File
Convert L/C Drawing File
Delete Pick or Game File
Exit



Open Drawing File
You can open a different drawing file by choosing Open Drawing File from the File menu.   
The shortcut key for this menu command is CTRL O.    The Open Drawing File dialog box is 
displayed.
A list of drawing files in the current directory is displayed in the Files list box.    There are 
three ways to select a file that is displayed.

1.    Double click the filename in the Files list box.
2.    Highlight the filename in the Files list box and press the ENTER key or click on the 

OK button.
3.    Type the name of the file in the Filename text box and press the ENTER key or click 

on the OK button.
After the selected file has been opened, the name of the lottery is displayed in the title bar 
of the main screen.    The total draws and date of the last draw is displayed in the status bar 
at the bottom of the main screen.



Create New Drawing File
You can create a new drawing file by choosing Create New Drawing File from the File 
menu.    The Create New Drawing File dialog box is displayed.
You must enter the following information for the lottery that you are creating the file for:
Lottery Name
Enter the full name of the lottery.    The name that you enter here will appear in the title bar 
of Windows Lotto when the file is opened.
Total Numbers Drawn
Enter the number of numbers that are drawn in this lottery.    For example, for the Florida 
lottery, you would enter 6 for the total numbers drawn.    If your lottery has one or more 
bonus numbers, be sure to include the bonus number(s) in the total.
Highest Number Drawn
Enter the highest number that can be drawn in this lottery.    For example, in the Florida 
lottery, the highest number that can be drawn is the number 49.
Number Of Bonus Numbers
Enter the number of bonus numbers that are drawn in this lottery.    Enter a 0 if there are no 
bonus numbers.
Number Of Matches For Bonus
If the lottery has one or more bonus numbers, you must enter the number of regular number
matches required by the lottery before the bonus number is counted.    In most lotteries that 
use bonus numbers, there must be 5 regular number matches before the bonus number 
counts as a match.    One exception is the Pennsylvania Wildcard lottery that accepts 3 
matches.
After you have entered all the information in the Create New Drawing File dialog box, click on
the OK button.    The Save Drawing File As dialog box is then displayed.
The first eight letters of the lottery name that you entered in the Create New Drawing File
dialog box is the default filename for the new file.    The filename must include the extension 
".INF".    
Press the ENTER key or click on the OK button to accept the default filename that is 
displayed.
You can also type in a different filename in the Filename box.    Be sure to include the ".INF" 
extension.    DOS file naming rules must be followed when entering a name.
When you click on the OK button, the information file (INF) is saved and an empty drawing 
file (DTA) is created with the same name.
You must use the Open Drawing File command from the File menu to open the new file, 
once it has been created.



Convert L/C Drawing File
If you are using the DOS program "Lotto Challenger" from Data Solutions, you can choose 
Convert L/C Drawing File from the File menu to convert your Lotto Challenger drawing 
files to a format that can be read by Windows Lotto.    This saves you having to retype all the 
previous draw information into Windows Lotto. 
When this command is selected, two new files are created.    One file has an extension of 
"DTA" and contains the previous drawing information.    An information file with an extension 
of "INF" is also created that has the same name as the DTA file.    The original Lotto 
Challenger data file with an extension of "DAT" is not changed.
When you choose this command, the Convert Lotto Challenger    Drawing File dialog box
is displayed.
Lotto Challenger drawing files in the current directory are displayed in the Files list box.    If 
your Lotto Challenger drawing files are not displayed, you should change to the directory or 
drive that contains your Lotto Challenger data base files.    After you have selected a data 
base file to convert, another dialog box is displayed.
Enter the full name of the lottery data base file that you are converting.    The name that you
enter will be displayed on the Windows Lotto title bar when the file is opened.    
After you have entered the name of the lottery you are converting, press the ENTER key or 
click on the OK button.    The Save Drawing File As dialog box is then displayed.
The name of the original Lotto Challenger drawing file is displayed in the Filename text box 
with an extension of "DTA".    To accept this name press the ENTER key.    A new Windows 
Lotto drawing file will be created with the drawing information from the original Lotto 
Challenger file.
If you want to save the new file under a different name, type the new name in the Filename
text box.    Be sure to include the extension ".DTA" as part of the name.
Once you have saved the file, you can use the Open Drawing File option in the File menu 
to load the converted drawing file.    



Delete Pick or Game File
To delete files created through the Quick Pick or Wheeling options, choose Delete Pick or 
Game File from the File menu.    The Delete Quick Pick or Game File(s) dialog box is 
displayed.
A list of Quick Pick files (extension PIK) and Game files (extension GAM) contained in the 
current directory is displayed in the Files list box.    Select the file that you want to delete.    
Another dialog box is displayed that asks you to confirm the deletion.
Click on Yes to delete the file, or No to cancel the deletion.    After you have clicked on Yes 
or No, a dialog box appears asking you if you want to delete another file.
Click on Yes to return to the Delete Quick Pick or Game File(s) dialog box.    Click on No 
when you are finished deleting files.



Exit
Choose the Exit command from the File menu to exit Windows Lotto.    The shortcut key for 
this option is CTRL X.    You can also use the Close command in the application Control 
menu to exit the program.



Drawings Menu
Edit
Check For Winning Games
Search Drawings



Edit
Choose the Edit command in the Drawings menu to add, change or delete a drawing.    You 
can also view or print drawings that were previously added.    The shortcut key for the Edit 
menu command is CTRL + E.
When you choose the command, the Edit Drawings dialog box is displayed.
Related Topics:

Add Drawing(s)
Change Drawing(s)
Delete Drawing(s)
View Drawing(s)
Print Drawing(s)



Add Drawing(s)
Use the Add Drawing option to enter all the numbers from the previous drawings for your 
lottery, and to keep the data base file updated as new drawings occur.
You should update your lottery database file(s) with the officially drawn numbers before 
using the Check For Winning Games command in the Drawings menu.
When you choose the Edit command from the Drawings menu, you are by default in the 
Add Drawing mode.    It is not necessary to click on the Add Drawing button.    
The drawing number for the next drawing is displayed in the Drawing Number text box.    
The last five drawings are displayed in a list box at the bottom of the dialog box.
Enter the drawing date in the format MONTH-DAY-YEAR.    For example, April 22, 1992 should 
be entered as 04-22-92.    Only enter the numbers; the hyphens are automatically inserted 
by the program.
Next enter the official numbers that were drawn.    If you enter two digits for a number, the 
insertion bar automatically advances to the next number field.    If you enter one digit for a 
number, you must press the TAB or ENTER key to advance to the next number field.
The program checks for invalid or duplicate dates, and numbers that are out of range or 
duplicates.    It will not let you save a drawing until both the date and the numbers drawn are
correct.
After you have entered all the numbers that were drawn, including Bonus numbers if 
applicable, the Add Drawing button has the focus.    Press the ENTER key or click on the Add
Drawing button to save the information.    
Another dialog box appears asking you to confirm that you have entered the correct date 
and numbers.
Press the ENTER key or click on the Yes button to save the drawing.      Click on the No 
button to cancel.    When you click on Yes, the new drawing information appears at the 
bottom of the list box in the Edit Drawings dialog box.    Total Draws and Last Draw Date
are also updated in the status bar at the bottom of the main screen.
After the drawing is saved, the insertion bar returns to the Drawing Date text box, where 
you can enter another drawing.    If there are no other drawings to enter, click on the OK 
button to close the Edit Drawings dialog box.



Change Drawing(s)
You can change information for previously entered drawings in the Edit Drawings dialog 
box.    To change drawing information, click on the drawing that you want to change in the 
list box at the bottom of the dialog box.    
You can scroll though the drawings in the list box by using the vertical scroll bar, or by 
clicking on the Next Drawing or Previous Drawing buttons.
Once you have selected a drawing, the drawing date, drawing number and numbers drawn 
are displayed in the text boxes at the top of the Edit Drawings dialog box.
Click on the box that you want to change and enter the correct date or numbers.    After you 
have made the change, click on any of the other option buttons in the Edit Drawings dialog
box.    You are then asked if you want to save these changes.
Click on the Yes button to save the changes, or click on the No button to cancel the 
changes.



Delete Drawing(s)
You can delete previous drawings in the Edit Drawings dialog box.    To delete a drawing, 
click on the drawing that you want to delete in the list box at the bottom of the dialog box.    
You can scroll though the drawings in the list box by using the vertical scroll bar, or by 
clicking on the Next Drawing or Previous Drawing buttons.
Once you have selected a drawing, the drawing date, drawing number and numbers drawn 
are displayed in the boxes at the top of the Edit Drawings dialog box.
Click on the Delete Drawing button.    You are then asked if it is OK to delete the drawing.
Click on the Yes button to delete the drawing, or click on the No button to cancel the 
deletion.



View Drawing(s)
You can view the previous drawings in the Edit Drawings dialog box.    Drawing information 
is displayed in the list box at the bottom of the dialog box.
You can scroll though the drawings in the list box by using the vertical scroll bar, or by 
clicking on the Next Drawing or Previous Drawing buttons.



Print Drawing(s)
You can print all drawings or a range of drawings from the Edit Drawings dialog box.    To 
print the drawings, click on the Print button.    The Print Options dialog box is displayed.
Enter the number of copies that you want printed in the Copies box.    
To print all drawings, click on the All option button.    To print a range of drawings, click on 
the Range option button.    Enter the From and To drawing number for the range that you 
want to print.
Click on the OK button to start printing, or click on the Cancel button to cancel printing.



Check For Winning Games
Choose the Check For Winning Games command in the Drawings menu to compare 
previously saved game tickets to the    official numbers that were drawn.    The shortcut key 
for the Check For Winning Games menu command is CTRL + C.
Prior to choosing this command, you must first enter the official numbers that were drawn 
by using the Edit command in the Drawings menu.    
You also must have saved at least one game file (a file with an extension of "GAM").    The 
Play command in the Wheels menu is used to generate your tickets and to save the game 
file(s).
When you choose the Check For Winning Games command, the Open Game File dialog 
box is displayed.
A list of game files in the current directory is displayed in the Files list box.    There are three
ways to select a file that is displayed.

1.      Double click the filename in the Files list box.
2.      Highlight the filename in the Files list box, and press the ENTER key or click on the 

OK button.
3.      Type the name of the file in the Filename text box, and press the ENTER key or 

click on the OK button.
After you have selected a game file, the Check For Winning Games dialog box is displayed.
A numbered list of the tickets in the Game file is displayed in the list box in the Check For 
Winning Games dialog box.    The number of matches is displayed in parenthesis to the 
right of each ticket.    If there are more tickets than are displayed in the list box, you can use 
the vertical scroll bar to view the other tickets.
The numbers that were drawn in the last drawing are displayed below the tickets list box.    
The total number of games in the file is displayed to the right of the numbers drawn.    A 
summary of the winning matches for the game file appears below the numbers drawn.    The 
name of the Game file is displayed at the bottom of the dialog box.
To print the winning ticket information, select the Print button.    The Print Options dialog 
box is displayed.      
 Enter the number of copies that you want printed in the Copies box.    Click on the OK 
button to begin printing, or click on Cancel button to cancel printing.    When you are 
finished viewing or printing the tickets, click on the OK button to close the Check For 
Winning Games dialog box.



Search Drawings
The Search Drawings command in the Drawings menu allows you to enter between 3 and
18 numbers to check against past drawings in the data base file.    You can, for example, 
check the numbers you are about to play to see how they have done in the past.    You can 
also easily check old tickets for winners. 
When you select the Search Drawings command, the Search Drawings dialog box is 
displayed.
Enter from 3 to 18 numbers that you want to search for in the data base file.    If you enter 
two digits for a number, the insertion bar will automatically advance to the next number 
field.    If you only enter one number in a text box, you will have to press the ENTER or TAB 
key to advance to the next field.
After you have entered the numbers to search for, enter the number of drawings to search.    
The total number of drawings in the data base file is displayed as a default.
Click on the OK button to begin the search.    Click on the Cancel button to cancel the 
search and close the Search Drawings dialog box. 
When you click on the OK button,    the Search Selections Found dialog is displayed.
A    list of drawing dates and matching numbers is displayed in a list box in the dialog box.    
Only drawing dates with three or more matching search numbers are displayed.    Use the 
vertical scroll bar to view the tickets if necessary.
A summary of the winning matches for the data base file appears below the list box.    The 
number of drawings searched is displayed to the right of the summary.    The numbers used 
in the search are displayed at the bottom of the dialog box.
To print the information, select the Print button.    The Print Options dialog box is 
displayed.      
 Enter the number of copies that you want printed in the Copies box.    Click on the OK 
button to begin printing, or click on Cancel button to cancel printing.    When you are 
finished viewing or printing the matching tickets, click on the OK button to close the Search
Selections Found dialog box.



Statistics Menu
History
Hot Number Cutoff
Number Statistics/Trend Chart
Skip and Hit Chart
Sequence Chart
Repeating Sets Chart
Drawing Summary/Quick Pick



History
Choose the History command from the Statistics menu to set time back a particular 
number of draws.    History is set to 0 (off) by default.    The current History setting is 
displayed in the status bar at the bottom of the main screen.
Once History is set to 1 or more draws, the program performs it calculations up to the draw 
that History is set to.
History can be used to test number systems on previous draws.    For example, if you want to
test how many winning matches you would have had with a particular wheeling system 10 
draws ago, you would enter 10 for History.
You would then select the Quick Pick option from the Drawing Summary command in the 
Statistics menu.    Quick Pick picks your numbers based on a statistical analysis of draws up
to the draw History is set to.    The resulting Quick Pick numbers are saved to a file.
Next choose the Play option from the Wheels menu and select the wheeling system that 
you want to test.    Load the Quick Pick file that you just saved.    The numbers in the Quick 
Pick file are substituted into the wheeling system and saved in a game file.
Finally select History from the Statistics menu and set it to 9 draws.    Choose the Check 
For Winning Games command from the Drawings menu to compare the tickets from the 
wheeling system to the numbers picked in the next drawing.
When you select the History command, the History dialog box is displayed.
Enter the number of draws that you want to go back in History.    Press the ENTER key or 
click on the OK button to accept the value entered.    The new value is displayed in the 
status bar at the bottom of the main screen.
The new value for History remains in effect until you load another data base file or exit the 
program.    When a new data base file is opened, the value of History is always set to 0.



Hot Number Cutoff
Choose the Hot Number Cutoff command in the Statistics menu to change the number of
last draws for a number to be considered Hot.    The current value for the Hot Number Cutoff 
is displayed in the status bar at the bottom of the main screen.
The default number of draws for a Hot number is 10 draws.    In other words, any number 
drawn at least once in the past 10 draws is considered to be Hot.
We recommend that you use the default of 10 draws.    We have found that this setting works
best for most lotteries.    However, you are free to change it and experiment with other 
settings. 
The Hot Number Cutoff also affects how a Cold number is determined.    Using the default 
cutoff of 10 draws, a Cold number is then any number that has not been drawn in the past 
10 draws.
When you select the Hot Number Cutoff command, the Hot Number Cutoff dialog box is 
displayed.
Enter the number of past draws that you want for a number to be considered Hot.    Press the
ENTER key or click on the OK button to accept the value entered.    The new value is 
displayed in the status bar at the bottom of the main screen.
The new value remains in effect until you open another data base file or exit the program.    
When a data base file is opened, the value of the Hot Number Cutoff is always set to 10 
draws.



Number Statistics/Trend Chart
Choose the Number Statistics/Trend Chart command from the Statistics menu to view 
or print number statistics for your lottery.      There must be at least one drawing in the data 
base file to use the command.    The shortcut for this menu option is CTRL + N.
The chart shows Number Frequency, Hot Numbers, Last Draw Numbers, Cold Numbers, Due 
Numbers and Average Number of Draws.
Calculations are performed on all draws in the data base up to and including the last draw, 
unless History is on.    If History is on, then calculations are performed on all draws in the 
data base minus the number of draws History is set to.
A Trend Chart that gives a different perspective of the number statistics can be displayed or 
printed.
When you select the Number Statistics/Trend Chart command, the Calculating Values 
message box is displayed.
Once the calculations are complete, the Number Statistics dialog box is displayed.
All the numbers for the lottery are displayed in the Frequency list box, starting with the 
numbers that have been drawn the most, down to the numbers that have been drawn the 
least. Use the vertical scroll bar to view all the numbers. 
The number of times the number has been drawn is displayed in parenthesis to the right of 
each number.    The date the number was last drawn is displayed to the right of its frequency.
An asterisk next to a number indicates that the number was drawn in the last drawing.
The total number of drawings is displayed above the Frequency list box next to the 
Frequency title.    The Average Draws for all numbers is displayed below the Frequency list 
box.
All the Hot numbers are displayed in the Hot number list box, starting with the Hot numbers 
that have been drawn the most in the last 10 draws (assuming that the Hot Number Cutoff is
set at the default of 10 draws).    Use the vertical scroll bar, if necessary,    to view all the Hot 
numbers.
The number of times the Hot number has been drawn in the past 10 draws is displayed in 
parenthesis to the right of each number.    An asterisk next to a Hot number indicates that 
the number was drawn in the last drawing.    The total number of Hot numbers is displayed 
above the Hot number list box next to the Hot number title.
All the Cold numbers are displayed in the Cold numbers list box, starting with the Cold 
numbers that have not been drawn for the longest time.    Use the vertical scroll bar, if 
necessary, to view all the Cold numbers.
The number of draws since the number was last drawn is displayed in parenthesis to the 
right of each Cold number.    An asterisk next to a Cold number indicates that the number is 
a Due number.    A Due number is a Cold number that is in the upper third of the Number 
Frequency list box.
The total number of Cold numbers is displayed above the Cold number list box next to the 
Cold number title.
To print the number statistics, click on the Print button in the Number Statistics dialog 
box.    The Print Options dialog box is displayed. 
Enter the number of copies that you want to print in the Copies box.    Click on the OK 
button to begin printing, or click on the Cancel button to cancel printing.
Click on the OK button in the Number Statistics dialog box when you are finished viewing 



or printing the Number Statistics.
Related Topics:

Trend Chart



Trend Chart
Click on the Trend Chart button in the Number Statistics dialog box to display the Trend 
Chart.
The chart displays a different color vertical bar for Hot numbers, Last Draw numbers, Cold 
numbers and Due numbers.    A legend for the different colors is displayed in the lower right 
hand corner of the dialog box.
If you don't have a color monitor, you may want to select the Patterns option button.    The 
chart then displays different black and white patterns for Hot numbers, Last Draw numbers, 
Cold numbers and Due numbers.
The horizontal axis of the chart represents the numbers in your lottery and is numbered from
1 to the highest number.    Below the numbers are the letters H, L, C, and D.    These letters 
indicate whether the number is Hot, Last, Cold or Due.
The vertical axes represents the frequency for each number.    The top of the vertical axis 
represents the most times any number has been drawn. 
A horizontal line divides the chart and represents the average draw frequency for all 
numbers.    Numbers that go above this line are above average in frequency.    Numbers that 
fall below the line are below average.
Click on the Print button to print the chart.    The chart prints in the patterns mode, even if 
the Colors option is active.    This makes the chart easier to read on a black and white 
printer.



Skip and Hit Chart
Choose the Skip and Hit Chart command from the Statistics menu to identify trends of 
numbers when determining which numbers to play in the next drawing.    There must be at 
least two drawings in the data base file to use this command.    The shortcut for the Skip and 
Hit Chart is CTRL + H.
When the Skip and Hit Chart command is selected, the Calculating Values message box 
is displayed.
When all the values for each number in your lottery have been calculated, the Skip and Hit
Chart is displayed.
The first vertical column on the left represents all the numbers in your lottery.    Use the 
vertical scroll bar to view numbers 11 and up.    
The 2nd through 25th column (0 to 24) represent the Skip and Hit frequency for each 
number.    Use the horizontal scroll bar to view columns 20 to 24.
If the number 3 in the first column has a 4 under the second column heading labeled "00," 
the number 3 has immediately reappeared in the very next drawing a total of 4 times.    
The third column labeled "01" represents the number of times the number in the first 
column has appeared, skipped one drawing, and then reappeared again.    The fourth column
labeled "02" represents the number of times the number in the first column has appeared, 
skipped two drawings, and then reappeared again, etc.    
Your job is to look at the skip performance of individual numbers based on their Skip and Hit 
frequency when selecting numbers.    If a number shows a tendency to appear and then skip 
2 or 3 drawings before it reappears, you would want to select that number to play if it last 
appeared 2 or 3 drawings back.
Click on the Help button in the Skip and Hit Chart dialog box to display a help window on 
how to read the Skip and Hit Chart. 
The Help windows gives examples based on actual data in the chart.    Click the OK button to
clear the Help window.
Click on the Print button in the Skip and Hit Chart dialog box to print the chart.    The 
Print Options dialog box is displayed.
Enter the number of copies that you want to print in the Copies box.    Click on the OK 
button to print the chart, or click on the Cancel button to cancel printing.
Click on the OK button in the Skip and Hit Chart dialog box when you have finished 
viewing or printing the chart.



Sequence Chart
Choose the Sequence Chart command from the Statistics menu to view or print the 
number sequence chart for the last 25 draws.    There must be at least 1 drawing in the data 
base file to use this command.    The shortcut for the Sequence Chart is CTRL + S.
This chart is helpful in determining which numbers to play in the next drawing by matching 
the number sequence against the Skip and Hit chart.    You can also determine the short term
trends of individual numbers and their drawing sequence.    
When the Sequence Chart command is selected, the Calculating Values message box is 
displayed.
When all the values for each number in your lottery have been calculated, the Sequence 
Chart is displayed.
The first vertical column on the left represents all the numbers in your lottery.    Use the 
vertical scroll bar to view numbers 11 and up.    
The 2nd through 25th column (1 to 25) represent the last 25 draws.    Use the horizontal 
scroll bar to view columns 21 to 25.
A "#" in the chart represents a regular number hit.    A "BB" represents a bonus number hit 
(if present).    The numbers that intersect the picked numbers (rows), and the last 25 draws 
(columns), represent the missed draw(s) since the last hit.
If the number 3 appears in row 1 (the number 1) and column 1 (the last draw), that means it
has been 3 draws since the number 1 last hit.    If a "#" appears in row 2 (the number 2) and 
column 1 (the last draw), that means that the number 2 was picked in the last draw.
If you see on the Skip and Hit chart that a number has a tendency to skip 3 times before 
hitting again, and the Sequence chart indicates that it has been 3 draws since the number 
hit, it would be to your advantage to play that number.
Click on the Help button in the Sequence Chart dialog box to display a help window that 
explains how to read the Sequence Chart. 
The Help window gives examples based on actual data in the chart.    Click on the OK button 
to clear the Help window.
Click on the Print button in the Sequence Chart dialog box to print the Chart.    The Print 
Options dialog box is displayed.
Enter the number of copies that you want to print in the Copies box.    Click on the OK 
button to print the chart, or click on the Cancel button to cancel printing.
Click on the OK button in the Sequence Chart dialog box when you have finished viewing 
or printing the chart.



Repeating Sets Chart
Choose the Repeating Sets Chart command from the Statistics menu to view or print 
repeating pair or triple number sets.    There must be at least 10 drawings in the data base 
file to use this command.    The shortcut for the Pairs command is CTRL + P.    The shortcut 
for the Triples command is CTRL + T.
You can specify to search from 10 drawings to all drawings.    After the results have been 
compiled, you can select the minimum frequency of occurrence of the sets that you want to 
view or print.
Related Topics:

Pairs
Triples



Pairs
When the Pairs command is selected, you are asked to enter the number of past drawings 
to check for repeating pairs.
The number defaults to the total number of drawings in the data base file.    However you 
can enter a number from 10 to the total number of drawings.    Press the ENTER key or click 
on the OK button to accept the value.    Click on the Cancel button to cancel the search.
During the data base search, the Calculating Values message box is displayed.
After the drawings have been searched, another dialog box is displayed that lists the 
number of occurrences found.    
The number of occurrences are listed from the largest down to the smallest.    Use the mouse
or keyboard to select the minimum number of occurrences to display or print.
For example, if you select 4 occurrences, only repeating pairs that occur 4 or more times in 
the number of drawings specified will be displayed or printed.
Once you have selected the number of occurrences, the list box is filled with pairs that are 
equal to or above the number specified.
The repeating pairs are displayed from the highest number of occurrences down to the 
minimum number of occurrences that you specified.    The number in parenthesis to the right
of each pair indicates how many occurrences were found.    Use the vertical scroll bar to view
all the repeating pairs.
Click on the Print button in the Repeating Pairs dialog box to print the repeating pairs.    
The Print Options dialog box is displayed.
Enter the number of copies that you want to print in the Copies box.    Click on the OK 
button to print the repeating pairs, or click on the Cancel button to cancel printing.
Click on the OK button in the Repeating Pairs dialog box when you have finished viewing 
or printing the pairs.



Triples
When the Triples command is selected, you are asked to enter the number of past drawings
to check for repeating triples.
The number defaults to the number of drawings in the data base file.    However you can 
enter a number from 10 to the total number of drawings.    Press the ENTER key or click on 
the OK button to accept the value.    Click on the Cancel button to cancel the search.
During the data base search, the Calculating Values message box is displayed.
After the search is complete, a dialog box is displayed listing the number of occurrences 
found for repeating triples. 
The number of occurrences are listed from the largest number down to the smallest number. 
Use the mouse or keyboard to select the minimum number of occurrences to display or 
print.    
For example, if you select 4 occurrences, only repeating triples that have occurred 4 or more
times will be displayed or printed.
Once you have selected the minimum number of occurrences, the list box is filled with sets 
of triples that are equal to or above the number of occurrences specified.
The repeating triple sets are displayed from the highest number of occurrences down to the 
minimum number of occurrences specified.    A number in parenthesis to the right of each 
triple set indicates how many occurrences were found.    Use the vertical scroll bar to view all
the triples.
Click on the Print button in the Repeating Triples dialog box to print the triple sets.    The 
Print Options dialog box is displayed.
Enter the number of copies that you want to print in the Copies box.    Click on the OK 
button to print the triples, or click on the Cancel button to cancel printing.
Click on the OK button in the Repeating Triples dialog box when you have finished viewing
or printing the triples.



Drawing Summary/Quick Pick
Choose the Drawing Summary/Quick Pick command from the Statistics menu to view or 
print a statistical analysis of previous drawings.    There must be at least 21 drawings in the 
data base file to use this option.    The shortcut for this command is CTRL + D.
Each drawing is analyzed to determine how many numbers were in the following categories:

1.      1 to 12 numbers
2.      13 to 31 numbers
3.      32 and up numbers
4.      Hot numbers
5.      Last Draw numbers
6.      Cold numbers
7.      Due numbers
8.      Odd numbers
9.      Even numbers
10. Sum of numbers

After all drawings have been analyzed, averages and percentages are calculated for each of 
the above categories and displayed at the bottom of the summary.
These calculations are important when picking your numbers.    For example, if the summary 
shows that Hot numbers make up 50% of the numbers drawn each week, then it is to your 
advantage if 50% of the numbers you play are Hot numbers.
If you choose the Quick Pick option from the Drawing Summary dialog box, the program 
automatically picks the best numbers to play, based on the statistics from the Drawing 
Summary.
For example, if you want to wheel 18 numbers, Quick Pick will determine how many of those 
18 numbers should be Hot, Cold, etc., based on the drawing summary results.    The resulting
18 numbers are saved to a PIK file that can be loaded into one or more of the wheeling 
systems in the Wheels menu.
Related Topics:

Drawing Summary
Quick Pick



Drawing Summary
When the Drawing Summary/Quick Pick command is selected, you are asked to enter the 
number of drawings to include in the summary.
The default number of drawings that is displayed is the total number of drawings in the data 
base minus the Hot Number Cutoff setting.    If there are 200 drawings in the database, and 
the Hot Number Cutoff is set to 10 drawings, then the default for the Drawing Summary will 
be 190 drawings.    
It is necessary to subtract the Hot Number cutoff from the total drawings because it is not 
possible to tell if a number is Hot or Cold for the first few drawings in the database.
Enter the number of drawings to include in the summary.    The minimum number allowed is 
11 drawings.    Press the ENTER key or click on the OK button to accept the number.    Click 
on the Cancel button to cancel the drawing summary.    
There are many complex calculations necessary for each drawing.      If you run the summary 
for hundreds of drawings, it could take several minutes to complete.
A message box is displayed that shows the progress of the calculations.
When all the drawings that you specified have been analyzed, the Drawing Summary 
dialog box is displayed.
The drawing dates are displayed in the far left vertical column.    The statistics for each 
drawing are displayed in the columns to the right of each date.    Use the vertical scroll bar to
view other drawings that are not displayed.
Averages and percentages for each category are displayed at the bottom of each column.    
These values are used when you select the Quick Pick option to pick your numbers.
Click on the Print button in the Drawing Summary dialog box to print the Drawing 
Summary.    The Print Options dialog box is displayed.
Enter the number of copies to print in the Copies box.    Click on the OK button to start 
printing, or click on the Cancel button to cancel printing.
Click on the OK button in the Drawing Summary dialog box when you are finished viewing 
or printing the Drawing Summary.



Quick Pick
When you click on the Quick Pick button in the Drawing Summary dialog box, the Quick 
Pick dialog box appears.
Enter the total number of numbers that you want picked in the Total Numbers box and 
press the ENTER key.    For example, if you are going to play a wheeling system that has 18 
numbers and 42 tickets, you should enter the number 18 in the Total Numbers box.
The area to the right of the Total Numbers box is filled with the numbers as they are picked
in the categories in the lower part of the dialog box.    The numbers are displayed in the 
order that they are picked.    This is the same order that is used when the numbers are 
substituted into the wheeling systems.
When the insertion bar moves to the 1 to 12 range box and the 13 to 31 range box, the 
program automatically calculates how many numbers to pick in these ranges, based on 
statistics from the Drawing Summary.    You can press the ENTER key to accept these values,
or type in other values.
You cannot enter a value in the 32 and up range box, since this value is automatically 
calculated by subtracting the value entered for the 1 to 12 range and the 13 to 31 range 
from the Total Numbers value.
The area to the right of the three range boxes is filled with numbers that fall within these 
ranges as they are picked in the categories in the lower part of the dialog box.
If you have specific numbers that you want to wheel, enter them in the Favorite numbers 
box.    For example, after analyzing the Skip and Hit Chart, Sequence Chart, Repeating Pairs 
Chart and Repeating Triples Chart, you may determine that certain numbers have a high 
probability of hitting next.
To be sure that these numbers are in the numbers that you wheel, enter them in the 
Favorite numbers box.    Each number that you enter should be separated by a space.    
When you press the ENTER key, the numbers are displayed to the right of the corresponding
range categories above, and to the right of the corresponding statistical categories below.    
They are also displayed to the right of the Total Numbers box.
When the insertion bar moves to the Hot numbers, Last Draw numbers, Cold numbers 
and Due numbers boxes, the program automatically calculates how many numbers to pick 
for each of these categories.    You can press the ENTER key to accept the values displayed, 
or type in other values.
After you press the ENTER key for each category, the program picks the specified amount of
numbers from that category and displays them to the right of the number box.    
For example, if a 6 is displayed for Hot numbers, the program picks 6 numbers that are 
currently Hot and displays them to the right of the Hot numbers box.    
If there are not 6 numbers that are currently Hot, then the program will only display the 
number of Hot numbers that it finds.    The value displayed in the Hot numbers box will 
automatically be decreased to the number of Hot numbers that the program finds.
The numbers that are picked for each category must meet the range requirements specified 
above.    For example, suppose    that you specify that you want two numbers in the 1 to 12 
range.    If you entered 3 numbers in the Favorite numbers box that were in the 1 to 12 
range, the program would only accept 2 of the 3 numbers that you entered.
You also have the option of letting the program randomly pick your numbers.    Enter the 
number of random numbers in the Random numbers box.    The numbers are picked at 
random from all categories and displayed to the right of the box.    The random numbers that
are picked must also meet the range requirements specified above.



Each time a number is picked in one of the lower categories, the Remaining picks box at 
the bottom of the dialog box is decreased by one.    When the value of the Remaining picks
box is zero, all the numbers have been picked.
If you get down to the Random numbers box and find that the Remaining picks value is 
not zero, this means that the program could not find enough numbers in one or more of the 
above categories.    
At this point you may want the program to randomly pick the remaining picks.    To do this, 
enter the number of remaining picks in the Random numbers box.
Another alternative would be to press the ENTER key to go through the other categories 
again.    For example, lets say that you have one remaining pick when you get down to the 
Random numbers box.    
If you press the ENTER key one time, the insertion bar moves back to the Hot numbers box. 
If the program had previously picked 10 Hot numbers, you could increase the number of Hot 
numbers to 11.    If the program finds another Hot number, the Remaining picks box should 
display the number zero.
When the value for Remaining Picks is zero, you cannot make any further changes.    The 
Save button in the Quick Pick dialog box has the focus.    Press the ENTER key or click on 
the Save button to display the Save Pick File dialog box.
A list of Quick Pick files that were previously saved is displayed in the Files list box.    Each 
Quick Pick file has an extension of "PIK."    There are three ways to save your Quick Pick 
numbers to an existing filename.

1.      Double click the filename in the Files list box.
2.      Highlight the filename in the Files list box, and press the ENTER key or click on the 

OK button.
3.      Type the name of the file in the Filename text box, and press the ENTER key or 

click on the OK button.
When you save to an existing file, the Quick Pick numbers that were originally saved in the 
file are replaced with the new Quick Pick numbers.
To save your numbers to a new filename, enter the name of the file in the Filename box.    It
is not necessary to add the ".PIK" extension to the name.    The program will automatically 
add the extension to the name after you press the ENTER key or click on the OK button.
After you save the file, the focus returns to the Print button in the Quick Pick dialog box.    
To print your Quick Pick numbers, press the ENTER key or click on the Print button.    The 
Print Options dialog box is displayed.
Enter the number of copies that you want printed in the Copies box.    Click on the OK 
button to start printing, or click on the Cancel button to cancel printing.
Click on the Clear button in the Quick Pick dialog box if you want to pick another set of 
Quick Pick numbers.    The previous set of Quick Pick numbers is cleared and the insertion 
bar returns to the Total Numbers box.    Repeat the previous instructions to pick a new set 
of numbers.    If you save more than one Quick Pick file, be sure to use a unique filename for 
each set of picks.
Click on the OK button when you have finished picking your numbers.    The Quick Pick 
dialog box disappears and the Drawing Summary dialog box is displayed again.    Click on the
OK button in the Drawing Summary dialog box when you are finished viewing or printing 
the Drawing Summary.
After you have saved your Quick Pick numbers, the next logical step is to Play those 
numbers in one or more of the 24 wheeling systems in the Wheels menu.    





Wheels
Choose the Wheels menu command to play or edit one or more Wheeling systems.
Four Full Wheeling Systems are provided for Pick 5 and Pick 6 games.    Twenty Abbreviated 
Wheeling Systems are provided for Pick 5, 6 and 7 games.    You can use the Edit command 
in the Wheels menu to enter other Abbreviated wheeling systems.    
The wheeling systems use the Quick Pick files that contain the numbers that you want to 
play.    The numbers in the Pick file are substituted with the numbers in the wheeling system 
to generate game tickets.    The tickets are saved to a Game file and printed so that you can 
fill out your bet slips.
Use the Check For Winning Games option in the Drawings menu each week to check the
tickets in your game file(s) against the officially drawn numbers.    
To illustrate how wheeling systems work, we will use one of the wheeling systems provided 
for Pick 6 games.    This wheeling system uses 10 numbers and generates 15 tickets.    The 
system guarantees that if the 6 numbers drawn are in the 10 numbers you play, you will win
at least a second prize (5 out of 6).
If you choose the Edit Command from the Wheels menu, and then select the system that 
reads 10 numbers, 15 games 5/6, you will see 15 tickets with the following numbers:

01.    01 02 03 04 05 06
02.    01 02 03 07 08 09
03.    01 02 04 06 09 10
04.    01 02 06 07 08 10
05.    01 03 04 05 07 10
06.    01 03 04 08 09 10
07.    01 05 06 07 08 09
08.    01 05 06 08 09 10
09.    02 03 04 05 07 08
10.    02 03 05 06 08 10
11.    02 03 05 07 09 10
12.    02 04 05 07 08 09
13.    02 04 05 07 08 10
14.    03 04 06 07 08 09
15.    03 04 06 07 09 10

Notice that none of the numbers in the system are greater than 10.    This is because the 
numbers displayed are not the actual numbers that you are going to play.    The numbers 
displayed are the order of substitution for the numbers in the Quick Pick file.
To illustrate how this works, let's say that the following 10 numbers are picked in the Quick 
Pick option, and saved to a Quick Pick file in the following order:

12 15 20 23 28 30 34 39 43 49
To play these numbers in the wheeling system that we just looked at, you would choose Play
command from the Wheels menu.    Next you would choose Abbreviated, and then the 



system 10 numbers, 15 games 5/6. 
You would then select the Quick Pick file with the 10 numbers that you just saved.    The 
Quick Pick numbers in the file are substituted into the wheeling system in the order shown 
above.
For example, the number 12 from the Quick Pick file is substituted for the number 1 in the 
original system because the number 12 is the first number in the file.    The Number 15 is 
substituted for the number 2, etc.
When all the numbers are substituted, the resulting tickets would like the following:

01.    12 15 20 23 28 30
02.    12 15 20 34 29 43
03.    12 15 23 30 43 49
04.    12 15 30 34 39 49
05.    12 20 23 28 34 49
06.    12 20 23 39 43 49
07.    12 28 30 34 39 43
08.    12 28 30 39 43 49
09.    15 20 23 28 34 39
10.    15 20 28 30 39 49
11.    15 20 28 34 43 49
12.    15 23 28 34 39 43
13.    15 23 28 34 39 49
14.    20 23 30 34 39 43
15.    20 23 30 34 43 49

These tickets would then be saved to a Game file and later compared to the official numbers
that are drawn in the next drawing.    They would also be printed so that you could fill out 
your bet slips.
Related Topics:

Play
Edit



Play
When you choose the Play command from the Wheels menu, you can select to play a Full 
wheeling system or an Abbreviated wheeling system.
Related Topics:

Full
Abbreviated



Full
There are 4 Full systems included for Pick 5 and Pick 6 games.    A Full system 
mathematically covers every possible combination of the numbers wheeled.
For example, one of the Pick 6 Full systems has 28 combinations of 6 numbers to cover 
every possible combination of the 8 numbers played.
An advantage to using a Full system is the number of winning hits received when just a few 
of the numbers wheeled match.    In an 8 number Full system, a 5 number match will 
produce winning prizes on every ticket.    
Another advantage is that you are guaranteed to have a jackpot win when the officially 
drawn numbers are in the group of numbers that you wheel.
A disadvantage of a Full wheeling system is the geometrical increase in the number of 
tickets that you must purchase to cover a larger group of numbers to wheel.    
An 18 number Full wheeling system would require more than 18,000 bets to cover every 
possible combination of 6 numbers with the 18 numbers you play.
When you choose the Full command from the Wheels menu, and then choose one of the 4 
Full systems, the Open Quick Pick File dialog box is displayed.
You can select a Quick Pick File to wheel by using one of the following methods:

1.    Double click on the filename in the Files list box.
2.    Click on the filename in the Files list box, and then click on the OK button or press 

the ENTER key.
3.    Type the name of the file in the Filename box, and then click on the OK  button or 

press the ENTER key. 
After the Quick Pick file is loaded and the numbers in the file have been substituted into the 
wheeling system, the Full Wheeling System dialog box is displayed.
The resulting tickets are displayed in the ticket list box.    Use the vertical scroll bar to view 
tickets that are not displayed.    When the tickets are first displayed, they are displayed in 
sorted order from the lowest to the highest number.    It is easier to fill out your bet slips if 
the tickets are in sorted order.    
Sorted order is not the same order as was in the original number system before the Quick 
Pick numbers were substituted.    If you would prefer to see the tickets in the order of the 
original numbers, click on the Unsorted option button.
The Win Guarantee, Numbers Played and Quick Pick File are displayed at the bottom 
of the dialog box.    
Click on the Save button to save the ticket information to a Game file.    The Game file is 
used by the Check For Winning Games command in the Drawings menu to find out how 
many winning tickets you have after the official numbers have been drawn.
When you click on the Save button, the Save Game File dialog box is displayed.
You can select a previously saved Game file using one of the following 3 methods:

1.    Double click on the filename in the Files list box.
2.    Click on the filename in the Files list box, and then click on the OK button or press 

the ENTER key.
3.    Type the name of the file in the Filename box, and then click on the OK button or 

press the ENTER key.



When you save to a previously saved Game file, the tickets that were originally in the file are
replaced by the new game tickets.
To save the Game file under a new name, type the name of the file in the Filename box, 
and click on the OK button or press the ENTER key.    It is not necessary to add the 
extension "GAM" to the filename.
After the Game file has been saved, the focus is on the Print button in the Full Wheeling 
System dialog box.    When you press the ENTER key or click on the Print button, the Print 
Options dialog box is displayed.
Enter the number of copies to print in the Copies box.    Click on the OK button to start 
printing, or click on Cancel to cancel printing.    
Click on the OK button in the Full Wheeling System dialog box when you have finished 
viewing or printing the tickets.



Abbreviated
Twenty Abbreviated wheeling systems are included for Pick 5, 6 and 7 games.
The biggest advantage of an Abbreviated system is with the much larger group of numbers 
you can cover at a reasonable cost, while still maintaining guaranteed wins when the 
officially drawn numbers appear in your much larger group of numbers wheeled.
When you choose the Abbreviated command from the Wheels menu, a list of 20 systems 
is displayed.    Each system name tells how many numbers are played in the wheel, the 
number of games, and the prize guarantee.    
A prize guarantee of 4/6 means that if 6 of the officially drawn numbers appear in your 
larger group of wheeled numbers, then you are guaranteed a match of 4 numbers.    
When you choose one of the 20 Abbreviated wheeling systems, the Open Quick Pick File 
dialog box is displayed.
You can select a Quick Pick File to wheel by using one of the following methods:

1.    Double click on the filename in the Files list box.
2.    Click on the filename in the Files list box, and then click on the OK button or press 

the ENTER key.
3.    Type the name of the file in the Filename box, and then click on the OK  button or 

press the ENTER key. 
After the Quick Pick file is loaded and the numbers in the file have been substituted into the 
wheeling system, the Abbreviated Wheeling System dialog box is displayed.
The resulting tickets are displayed in the ticket list box.    Use the vertical scroll bar to view 
tickets that are not displayed.    When the tickets are first displayed, they are displayed in 
sorted order from the lowest number to the highest number.    It is easier to fill out your bet 
slips if the tickets are in sorted order.    
Sorted order is not the same order as was in the original number system before the Quick 
Pick numbers were substituted.    If you would prefer to see the tickets in the order of the 
original numbers, click on the Unsorted option button.
The Win Guarantee, Numbers Played and Quick Pick File are displayed at the bottom 
of the dialog box.    
Click on the Save button to save the ticket information to a Game file.    The Game file is 
used by the Check For Winning Games command in the Drawings menu to find out how 
many winning tickets you have after the official numbers have been drawn.
When you click on the Save button, the Save Game File dialog box is displayed.
You can select a previously saved Game file using one of the following 3 methods:

1.    Double click on the filename in the Files list box.
2.    Click on the filename in the Files list box, and then click on the OK button or press 

the ENTER key.
3.    Type the name of the file in the Filename box, and then click on the OK button or 

press the ENTER key.
When you save to a previously saved Game file, the tickets that were originally in the file are
replaced by the new game tickets.
To save the Game file under a new name, type the name of the file in the Filename box, 
and click on the OK button or press the ENTER key.    It is not necessary to add the 
extension "GAM" to the filename.



After the Game file has been saved, the focus is on the Print button in the Abbreviated 
Wheeling System dialog box.    When you press the ENTER key or click on the Print 
button, the Print Options dialog box is displayed.
Enter the number of copies to print in the Copies box.    Click on the OK button to start 
printing, or click on Cancel to cancel printing.    
Click on the OK button in the Abbreviated Wheeling System dialog box when you have 
finished viewing or printing the tickets.



Edit
Choose the Edit command from the Wheels menu to edit or replace any of the 20 
Abbreviated wheeling systems.    DO NOT attempt to replace a wheeling system unless you 
use a book on wheeling systems.    One book that we highly recommend is "The Only Way To 
Win At Lotto" by Robert Serotic.
When you choose one of the 20 Abbreviated wheeling systems to edit, the Edit Wheel dialog 
box is displayed.
The games for the system you chose are displayed in the Games list box.    Use the 
horizontal scroll bar to view games that are not currently displayed.
Click on the Print button to print all the games in the wheeling system.    The Print Options
dialog box is displayed.
Enter the number of copies to print in the Copies box.    Click on the OK button to start 
printing, or click on the Cancel button to cancel printing.
If you want to edit an existing system, you can only change the numbers in each game.    You
cannot change the number of numbers in the system, the number of games, or the prize 
guarantee.
To edit a game, click on the game number that you want to edit in the Games list box.    The 
numbers in the game then appear at the bottom of the Edit Wheel dialog box in the Game 
numbers boxes.    
To change one or more of the numbers in a game, click on the appropriate Game numbers 
box and enter the change.    Press the ENTER or TAB keys to go through all the boxes for 
that game.    Any changes made now appear in the Games list box.
To completely replace a wheeling system, click on the New button in the Edit Wheel dialog 
box.    The Games list box is cleared of all games and the insertion bar moves to the 
Numbers box.    Enter the number of numbers that will be played in the system.
In the Games box enter the total number of games in the new system.    Enter the number 
of numbers that are guaranteed to match in the Guarantee box.    Enter the number of 
correct numbers needed for the prize in the #'s are correct box.
The insertion bar then moves to the first Game numbers box.    The game number is 
automatically displayed in the Game box to the left.    Enter the numbers for that game. 
When all the numbers have been entered, the game appears in the Games list box.    The 
insertion bar returns to the first Game numbers box and the Game counter is increased by 
one.    
When you have entered all the games, the focus is on the OK button in the Edit Wheel 
dialog box.    Press the ENTER key or click on OK.    You are then asked if you want to save 
your changes.
Click on the Yes button to save the changes, or click on the No button to cancel all changes. 
When you save a new system, the new system name is automatically added to the 
Abbreviated wheeling system menu.



Help Menu
Index
Context Help
Using Help
About Windows Lotto



Index
Use this command to display the opening screen of Help.    The Index provides an 
alphabetical list of all the topics in the Help file.    You access Help topics by clicking on the 
underlined and/or green colored items in the list.    
From the Index, you can jump to step-by-step instructions for using Windows Lotto and 
various types of reference information.
Once you open Help, you can click the first button on the left in the Help window whenever 
you want to return to the Index.



Context Help
Context help means that you can access Help for specific Windows Lotto features without 
having to quit that feature or search through the index.    There are two kinds of context 
help; Active Help and Menu Help.
Related Topics:

Active Help
Menu Help



Active Help
Press the F1 key to activate Active Help.    Active Help relates to the dialog box or control 
that currently has focus.    For example, if an option button has the focus, pressing F1 
invokes a topic to be displayed that explains the functioning of that option button.



Menu Help
For help with specific menu items, choose Context Help from the Help menu or press 
SHIFT + F1.
When you choose Context Help, the mouse pointer changes to a box pointer.    Normal 
mouse and keyboard functions are now suspended.    For Help on a menu item, choose the 
menu item with the box pointer.    A Help window is displayed that gives an explanation of 
the menu item.



Using Help
Choose Using Help to learn how to use the Window's Help system.



About Windows Lotto
Choose About Windows Lotto from the Help menu to display a dialog box with the 
Windows Lotto version, Windows mode (Standard or Enhanced) and the amount of free 
memory.
Click on the OK button to close the dialog box.



Numbers picked that are in the range from 1 to 12.    Many people play numbers in this 
range, because they like to use birth dates, anniversary dates, etc.    If a drawing has a high 
percentage of numbers in this range, the cash prize tends to be smaller than for the 32 and 
Up range.



Numbers picked that are in the range from 13 to 31. Many people play numbers in this 
range, because they like to use birth dates, anniversary dates, etc.    If a drawing has a high 
percentage of numbers in this range, the cash prize tends to be smaller than for the 32 and 
Up range.



Numbers picked that are in the range from 32 and up.    If a drawing has a high percentage 
of numbers in this range, the cash prize tends to be larger than the other ranges.    



A wheeling system that guarantees that when a certain number of officially drawn numbers 
appear within the larger group of numbers wheeled, you will win one or more second or third
place prizes.



The total Number Frequency for all numbers in the lottery divided by the number of numbers
in the lottery.



A number is considered to be cold if it has NOT been drawn in the number of previous draws 
specified by the Hot Number Cutoff.    The default value for the Hot Number Cutoff is 10 
draws.



A file that contains the dates of previous drawings and the numbers that were drawn.    
Drawing files have an extension of "DTA".    Each drawing file also has an information file 
with the same name, but with the extension "INF".



An analysis of previous draws to determine how many numbers were Hot, Cold, Due, Last 
Draw, Odd and Even.    The statistics from the Drawing Summary are used by the Quick Pick 
option to pick the most likely numbers to occur next.



A Due Number is a Cold Number that is in the upper third of the Number Frequency Chart.    
In other words, Due Numbers are numbers that were active in the past, but are currently 
Cold.



The number of Even Numbers drawn in a draw.    Over a long period of time, the number of 
Even Numbers drawn is about equal to the number of Odd Numbers drawn.    However, it can
be beneficial to track Even Numbers to spot short term trends.



A wheeling system that guarantees a jackpot prize when the officially drawn numbers are in 
the group of numbers that were wheeled.



Tracking the past performance of lottery numbers to determine the most likely numbers to 
be drawn next.



The number of previous draws for which a number must occur in at least once to be 
considered a Hot Number. The program default is 10 draws.    If other words, if a number is 
drawn at least one time in the past drawings, it is considered to be a Hot Number.



A number is considered Hot if it has been drawn at least once in the number of previous 
draws specified by the Hot Number Cutoff.    The default value for the Hot Number Cutoff is 
10 draws.



Numbers that were drawn in the last drawing.    You will find that most drawings have at least
one number from the previous drawing.



The number of times a number has been drawn in previous drawings.



A chart that shows Number Frequency, Hot Numbers, Last Draw Numbers, Cold Numbers, 
Due Numbers and Average Draws Per Number.



The number of Odd Numbers drawn in a draw.    Over a long period of time, the number of 
Odd Numbers drawn is about equal to the number of Even Numbers drawn.    However, it can
be beneficial to track Odd Numbers to spot short term trends.



A chart that shows the performance of numbers in Pairs with other numbers.    Each number 
is compared with all previous drawings to determine which numbers appeared together, in 
frequencies of two or more times.



A chart that shows the performance of numbers in Triples with other numbers.    Each 
number is compared with all previous drawings to determine which numbers appeared 
together, in frequencies of two or more times.



This chart is used with the Skip and Hit Chart to determine which numbers are due to Hit 
next.    The chart can also be used to determine short term trends of individual numbers and 
their drawing sequence.



A chart that shows the past skip performance of individual numbers.    Normally used with 
the Sequence Chart to determine numbers that are due to hit.



The sum of all the numbers drawn in one drawing.    You should try to play numbers whose 
sum is close to the average sum for the previous drawings.



A graphical presentation of the Number Statistics Chart.



Mathematical systems that simplify the betting process, guarantee a prize when the 
numbers drawn appear in the group of numbers wheeled, and maximize your payoffs 
through multiple ticket hits.


